OFFICE AUTOMATION
Part : MS ACCESS

Course Code : DCSA 1302

Diploma in Computer Science and Application Programme
(DCSA Programme)

Writer
Mohammad Mamunur Rashid
School of Science and Technology
Bangladesh Open University

Editor
Mr. Abu Ahmed Ferdaus
Department of Computer Science and Engineering
University of Dhaka

Coordinator
Dr. K. M. Rezanur Rahman
School of Science and Technology
Bangladesh Open University

Bangladesh Open University
Dear learners,

Welcome all of you to open learning system of education at the Bangladesh Open University (BOU). Through a wide variety of distance education programmes, BOU extends learning opportunities to people across the country. This is the leading age of computer science, information and communication technology. To meet the increasing demand in IT field in the country, School of Science and Technology (SST) has been offering Diploma in Computer Science and Application (DCSA) programme since 1998. As we know that this technology field is changeable. So we have taken a programme to review and update contents of the courses included in DCSA programme. Under this programme we will review the all courses step by step. At present, we have updated content of the course “Office Automation (DCSA 1302)” and have introduced MS Access. Learners are requested to study content of MS Access instead of MS Foxpro.

I do believe that this module on MS Access will help the learners to follow the content of Access and to prepare themselves for examination. This course will help to grow the skill in database. If you face any problem please do not hesitate to contact regarding the study materials your course tutor.

I wish a fruitful semester and prosperous future.

Sincerely,

Dean
School of Science and Technology
Bangladesh Open University
Gazipur- 1705
Office automation is expected to receive a major thrust in all offices or organizations in the coming years in Bangladesh. This book introduces the learners with various facets of MS Access in office XP and help to know database operations using MS Access.

The book is supplied to learner as additional module of the main book “Office Automation”. Learners are requested to study MS Access consisting of unit-8 to unit-11 instead of content (units-8 to unit-11) on MS Foxpro of the book “Office Automation” and prepare themselves for examination. A brief summary of each the unit is presented the following sections.

The unit-8 introduces database and related topics and describes MS Access, inserting data etc.

The Unit-9 introduces sorting, filtering, indexing and creating relational database.

The Unit-10 describes MS Access quiring.

The Unit-11 describes form and MS Access reports generations.

The end of each lesson there are exercises or hands on practices. The exercise and hands as practice are useful to check what one has learned. A learner can check his/her understanding of the lesson by answering the questions. A list for reference books has been included at the end for further reading.
Office Automation

Part : MS ACCESS

Contents

Unit 8: Introduction to Database
Lesson 1: Understanding Database, Database Management System 1
Lesson 2: Getting Familiar with Microsoft Access for Windows 6
Lesson 3: Inserting Data to Database 12

Unit 9: Sorting, Filtering, Indexing and Creating Relationships Database
Lesson 1: Understanding Sorting and Filtering 25
Lesson 2: Understanding Indexing and Relationship 30

Unit 10: Microsoft Access Queries
Lesson 1: Different Types of Queries 39
Lesson 2: Creating Microsoft Access Queries 43
Lesson 3: Advanced Queries 52

Unit 11: Introduction to Form and Report
Lesson 1: Familiarize with form 65
Lesson 2: Designing Report 73
Lesson 3: Advanced Report 84

Answer Key to the MCQS 91

Reference book 92
Unit 8: Introduction to Database

Introduction

A database is an organized collection of data. This unit describes the basic concepts of database, Database Management System, advantage of Database Management System, Application of Database Management System. In this unit you will be familiar with Microsoft Access database.

Lesson 8.1: Understanding Database, Database Management System

Learning Objectives

On completion of this lesson you will be able to learn:

- about Data and Database.
- about Database Management System.
- objective of Database Management System.
- purpose of Database Management System.
- applications of Database Management System.
- function of Database.
- access Database Files.

8.1.1 Data

Generally, pieces of information are called data. In computing, data is also information but that has been translated into a form which is more convenient to manipulate or process by the computer.

8.1.2 Database

A database is a collection of data or information that is organized in such a manner so that it can easily be accessed, managed, updated and retrieved. Computerized databases are much more powerful than non-computerized databases because users can easily search and reorganize data in hundreds of ways. As for example- the telephone index of a non-computerized database contains names, addresses, and telephone numbers arranged alphabetically by last name so that it is easy to find information for a particular person but in computerized database, you could search by address, first name, or phone number, instead of just by last name.
Introduction to Database

Oracle, Microsoft SQL server, Sybase, DB2, DB2-UDB, Informix are the examples of commercial databases management system. MySQL, PostgreSQL, Predator are some free database management system.

How database is different from word-processors and spreadsheets?

- Word-processor- Works with text, graphics.
- Spreadsheets- Numbers, Data modeling, Statistical analysis.
- Database-Use same data for many purposes.

8.1.3 Database Management System

Database Management System (DBMS) is essentially a collection of interrelated data and a set of software programs (or group of programs) that provides storage, access, security, and other facilities of those data. From 8.1.2 we already know the collection of data is usually referred to as database. Database systems are designed to manage huge amount of data. The management of data involves both data definition and the manipulation of data. The DBMS acts as an interface between application programs and physical data files and provides tools to add, delete, display, print, search, select, sort, and update data.

8.1.4 Objective of Database Management System

The primary objective of DBMS is

- To provide a convenient way to store data into a database.
- To provide an efficient manner to retrieve data from database.

8.1.5 Purpose of Database Management System

In traditional file system each program has its own file, so too many files will be needed and there may be many redundant data that create inconsistency. Database Management System removes these disadvantages. The DBMS permits an organization to centralize data, manage them efficiently, and provide access to stored data by application programs. Database Management System can store data one time and allow multiple programs to access those data. So data redundancy and inconsistency is removed in Database Management System. A major purpose of a database management system is to provide users with an abstract view of data.
Office Automation

8.1.6 Applications of Database Management System

Databases touch all aspects of our lives.

- Human resources: Payroll.
- Banking: Transactions.
- Universities: Student information management system, library information system.
- Sales: customers, products, purchases.
- Manufacturing: inventory, orders, production.

8.1.7 Advantages of DBMS

- Find information quickly.
- Performs complex retrieval and data manipulation tasks based on queries.
- Data inconsistency and redundancy is reduced.
- Restricting unauthorized users.
- Providing backup and recovery.
- Better service to the users.
- Create mailing list for mail merges. This allows the user to send out letters containing personal information kept in database.

8.1.8 Database Management System Offers the Following Services:

- Data Definition.
- Data Maintenance.
- Data Manipulation.
- Data Display.
- Data Integrity.
8.1.9 Microsoft Access Database:

- **Database File**: Database file is the main file that represents the entire database. Example: student.mdb

- **Table**: A table is a collection of data about a specific topic. There can be multiple tables in a database. Example: student, employee.

- **Field**: Each column represents as field. Each field in a table has a field name; appearing at the top of the column. Tables usually contain multiple fields. Example: studentid, studentname, are the field name of student table.

- **Record**: Each row represents as record. For example, studentid, studentname fields make up a single student record.

- **DataType**: Datatypes are the properties of each field. It indicates the type of data that each field can hold. A field only has one datatype. For example text, number, date etc.
Exercise

1. **Multiple choice questions**

a. Pieces of information called
   
i) data  
ii) database  
iii) DBMS 
iv) none of the above.

b. Accuracy of the data ensures.
   
i) data integrity 
ii) data definition 
iii) data manipulation 
iv) data maintenance.

c. Which one is a free database system?
   
i) Oracle  
ii) Microsoft SQL server  
iii) Sybase 
iv) MySQL.

2. **Analytical questions**

1. What is database?
2. What is DBMS? What are the primary objectives of DBMS?
3. Discuss the services offer by the DBMS.
4. Discuss the purposes of DBMS.
5. What are the advantages of DBMS?
Lesson 8.2: Getting Familiar with Microsoft Access for Windows

Microsoft Access is a database software package. With Access you can create a computerized database. For example, you can use Access to organize the students who attend in a school, the courses they registered, and the instructors who teach them. After you create an Access database, you can search it, manipulate it, and extract information from it. Dear learners, this lesson introduce you to Access windows and teach how to create Access database.

Learning Objectives

On completion of this lesson you will be able to learn:

- access database objects.
- how to run Microsoft Access.
- creating database.

8.2.1 Microsoft Access Database Objects

The Objects bar lists the major types of objects in an Access database. Objects are as follows.
- Tables
- Queries
- Forms
- Reports
- Page
- Macros
- Modules.
Objects

<table>
<thead>
<tr>
<th>Tables</th>
<th>In Access, data is stored in tables. A table is a set of columns and rows, with each column referred to as a field. Each row of a table is referred to as a record. Each value in a field represents a single type of data.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Queries</td>
<td>Queries used to retrieve specific data from database and to answer questions about your data. For example, you can use a query to find the names of the employees in your database who live in a particular district.</td>
</tr>
<tr>
<td>Forms</td>
<td>Forms give the ability to choose the format and arrangement of fields. You can use a form to enter, edit, and display data.</td>
</tr>
<tr>
<td>Reports</td>
<td>Reports organize or summarize data so that you can print it or view it on screen. You often use reports when you want to analyze your data or present your data to others.</td>
</tr>
<tr>
<td>Macros</td>
<td>Macros give you the ability to automate tasks. You can use a macro to add functionality to a form, report, or control.</td>
</tr>
<tr>
<td>Modules</td>
<td>Like macros, modules give you ability to automate tasks and add functionality to a form, report, or control.</td>
</tr>
</tbody>
</table>

8.2.2 Starting Microsoft Access

Dear learners let us follow any one of the following way to start Microsoft Access

To start Microsoft Access:

Use the start button on the task bar to open run then type msaccess then press enter
Introduction to Database

Or
Use the Start button on the task bar to open: Programs -> MS Office -> Microsoft Access

Or
Double click on the Microsoft Access icon on the desktop.

Once Access is running an initial screen will be displayed and it looks as follows:

To exit Access, pull down the File menu and select the Exit menu item.

Or
You can click the cross( X ) at the top right corner of the window.
8.2.3 Creating Database

To create new databases choose Blank Database from "Task Pane" appear on the right-hand side of the screen and specify a new file name for the database. Use a descriptive name for the new database. Click on the OK button to create the new database.

To open an existing database choose open an Existing Database from "Task Pane" appear on the right-hand side of the screen, select More Files then navigates to the drive, highlight the existing database file on disk and click the open button to open the database.

To create a new database in Access

1. From the menu choose File -> New.
2. The "New File" Task Pane will appear on the right-hand side of the screen.
3. Click the option "Blank database" which will then ask you to name your database. Access databases are saved with the .mdb extension.
4. Name your file (we chose sst) and press Create. This will automatically save your blank database as sst.
5. The Access Database interface should now be displayed and you are ready to learn Access.

Now the database has been created. We can begin to create Access table.
Exercise

1. **Multiple choice questions**

   a. Table is a set
      i) columns
      ii) rows
      iii) columns and rows
      iv) field.

   b. File extension of Microsoft Access database
      i) .mdb
      ii) .dbf
      iii) .txt
      iv) .exe

   c. The core component of database is
      i) table
      ii) form
      iii) report
      iv) query.

2. **Analytical questions**

   1. Discuss about the objects of Microsoft Access database.
   2. Discuss the steps to create a database.
Lesson 8.3: Inserting Data to Database

Learning Objectives

On completion of this lesson you will be able to learn:

- data types.
- creating new tables.
- modifying tables.
- adding records.
- editing records.
- save records.
- deleting records.

8.3.1 Understanding Data Types

Data type determines the type of information that may be entered in that field. A field with a data type of text can store alphabetic characters and numbers. Generally you cannot perform mathematical calculations by using a text field. For example, you can use a text field to store a street address. Unless you do some manipulation, you cannot use the numbers in the street address in mathematical calculations. You will not be able to sum or average the numbers in an address field. Alternatively, you can assign a Test Score field a data type of Number. You can enter numbers into the field and then average, sum, or perform other calculations with the numbers. However, you cannot enter an alphabetic character in a number field.

<table>
<thead>
<tr>
<th>Data Types</th>
<th>Use</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text</td>
<td>Alphanumeric data. Use for text and for numbers that are not used in mathematical calculations. Use for names, addresses, and other relatively short pieces of text. It can store up to 255 characters.</td>
<td></td>
</tr>
<tr>
<td>Memo</td>
<td>Long text. Use for long pieces of text, such as notes and long descriptions. Can store up to 64,000 characters.</td>
<td></td>
</tr>
</tbody>
</table>
### 8.3.2 Tables

A table is a set of columns and rows. Each column is called a field. Within a table, each field must have a name and no two fields can have the same name. Each value in a field represents a single category of data. For example, a table might have three fields: employee id, Name, and Phone Number. The table consists of three columns: one for employee id, one for Name, and one for phone number. In every row of the table, the employee id field contains the employee id number, the Name field contains the employee name, and the Phone Number field contains the phone number of the employee. Each row in a table is called a record.
Example:

<table>
<thead>
<tr>
<th>Field</th>
<th>Table Name</th>
<th>Record</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee id</td>
<td></td>
<td>001</td>
</tr>
<tr>
<td>Name</td>
<td></td>
<td>Labib</td>
</tr>
<tr>
<td>PhoneNumber</td>
<td></td>
<td>01716115139</td>
</tr>
<tr>
<td></td>
<td></td>
<td>002</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Babul</td>
</tr>
<tr>
<td></td>
<td></td>
<td>01717224501</td>
</tr>
</tbody>
</table>

Here the employee table has 3 columns (Employee id, Name, Phone Number) and 2 rows or records of data.

8.3.3 How Data is organized in Tables?

Tables organize data into columns (called fields) and rows (called records). For example, each field in a Products table contains the same type of information for every product, such as the product's name. Each record in that table contains all the information about one product, such as the product's name, supplier ID number, units in stock, and so on.

8.3.4 Creating Microsoft Access Tables

Tables are the foundation of an Access database. Access stores data in tables. How to create a table, add fields to a table, assign data types to fields, and set field properties have been discussed in this section.

Creating a Table

To create Access table you can follow any of the three instructions below:

- Create a table in Design view, where you can add fields, define how each field appears or handles data, and create a primary key.
- Use the Table Wizard to choose the fields for your table from a variety of predefined tables such as products, employees, suppliers, order details.
- Entering data directly into a blank datasheet. When you save the new datasheet, Microsoft Access will analyze your data and automatically assign the appropriate data type and format for each field.
Create a Table in Design View

Creating a new table in design view requires the following steps:

1. In the Database window click on the Tables tab under Objects on the Access main screen.
2. Click on the new button.
3. Choose the Design View and click the OK button.
4. Define each of the fields in your table.
5. Click in the Field Name column and type a unique name for the field.
6. In the Data Type column keep the default (Text) or click in the Data Type column, click the arrow, and select the data type you want.
7. In the Description column, type a description of the information this field will contain. This description is displayed on the status bar when adding data to the field and is included in the Object Definition of the table. The description is optional.
8. To set the property of a field click the field whose property you want to set. General tab which appears lower portion of the window contains field property like FieldSize, Format, Input mask, Caption, Default Value, validation Text etc. FieldSize- You can enter maximum number of characters in the field. Default Value- You can enter a value automatically for new records. Format- Display layout for the field.
9. Designate a primary key by clicking on one of the fields that you want to define as primary key with the right mouse button and then choose Primary Key from the pop-up menu.
10. Save the table by pulling down the File menu and click Save.
11. Close the new table by pulling down the File menu and click close.

Dear learner you don't have to define a primary key, but it's usually a good idea, if you don't define a primary key; Microsoft Access asks if you want to create one for you when you save the table.
Create Table by Using the Table Wizard

Creating table by using table wizard is a quick way to create a database.

Creating new table by using the table wizard requires the following steps:

1. Click Tables tab under Objects, and then click New on the Database window toolbar.
2. Double-click Table Wizard.
3. Follow the directions in the Table Wizard dialog boxes.
Office Automation

**Table Wizard**

Which of the sample tables listed below do you want to use to create your table?

After selecting a table category, choose the sample table and sample fields you want to include in your new table. Your table can include fields from more than one sample table. If you're not sure about a field, go ahead and include it. It's easy to delete a field later.

---

**Sample Fields:**
- EmployeeID
- FirstName
- Address
- Salary

**Fields in my new table:**
- EmployeeID
- FirstName
- Address
- Salary

---

**Table Wizard**

What do you want to name your table?

Employees

Microsoft Access uses a special kind of field, called a primary key, to uniquely identify each record in a table. In the same way a license plate number identifies a car, a primary key identifies a record.

Do you want the wizard to set a primary key for you?

- Yes, set a primary key for me.
- No, I'll set the primary key.

---

Finish
Introduction to Database

Note If you want to modify or extend the resulting table, you can do so in Design View. In Design View, you can create new database objects and modify the Design View existing ones.

8.3.5 Opening Existing Table

1. In the Database window, click Tables under Objects.
2. Click the table you want to open.
3. Do one of the following:
   - Click Design on the Database window toolbar to open the table in Design view.
   - Click Open on the Database window toolbar to open the table in Datasheet view.

To change the structure of an existing table (modify, add or delete fields)

Follow the given instruction below to change the structure of an existing table:

1. Click on the Tables tab on the Access main screen
2. Highlight the name of the table to be modified and click on the Design button.
Office Automation

3. Make the necessary changes.

4. To add a field select the fields where you want to add then click right mouse button and choose insert rows from the popup menu and type a unique name for the field Name column.

5. Select the field that you want to delete then click right mouse button and choose delete rows from the popup menu.

6. Save the table by pulling down the File menu and choosing Save.

7. Close the table by pulling down the File menu and choosing Close.

After creating a table you can insert data into it. Access assigns data type to each field based on your entry. Your can enter data by typing in each field.

8.3.6 Entering Data to a Table

Data can be inserted, deleted or modified in tables using a simple spreadsheet-like display. To bring up this view of a single table's data, highlight the name of the table and then click on the Open button. In this view of the table, shown in the figure below, the fields (columns) appear across the top of the window and the rows or records appear below. This view is similar to how a spreadsheet would be designed.

Insetting, Editing or Deleting Record

Insert or edit data in datasheet

Open datasheet.

To add a new record, click New Record on the toolbar, type the data, and then press TAB to go to the next field. At the end of the record, press TAB to go to the next record.

To edit data within a field, click in the field you want to edit, and then type the data.

Dear learners, if you want to correct a typing mistake, press BACKSPACE. To cancel your changes in the current field, press ESC. To cancel your changes in the entire record, press ESC again before you move out of the field. When you move to another record, Microsoft Access saves your changes.
Note: at the bottom of the window the number of records is displayed. In this case, since the table was just created, only one blank record appears.

To add data to the table, simply type in values for each of the fields (columns). Press the Tab key to move between fields within a record. Use the up and down arrow keys to move between records. Enter the data as given below:

<table>
<thead>
<tr>
<th>Employee id</th>
<th>Name</th>
<th>Phone Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>004</td>
<td>mamun</td>
<td>01716115139</td>
</tr>
<tr>
<td>005</td>
<td>alim</td>
<td>01718353366</td>
</tr>
<tr>
<td>006</td>
<td>sharif</td>
<td>01728516824</td>
</tr>
</tbody>
</table>
To use keys to move around a table:

<table>
<thead>
<tr>
<th>Key to Press</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Tab</strong></td>
<td>Moves to the next field to the right. If you are in the last field in a record, moves you to the next record. If you are in the last record in a table, creates a new record.</td>
</tr>
<tr>
<td><strong>Left-Arrow</strong></td>
<td>Moves to the next field to the left. If you are in the first field in a record, moves you to the previous record.</td>
</tr>
<tr>
<td><strong>Shift+Tab</strong></td>
<td>Moves to the previous field. If you are in the first field in a record, moves you to the previous record.</td>
</tr>
<tr>
<td><strong>Right-Arrow</strong></td>
<td>Moves to the next field. If you are in the last field in a record, moves you to the next record. If you are in the last record in a table, creates a new record.</td>
</tr>
<tr>
<td><strong>Up-Arrow</strong></td>
<td>Moves you up one record.</td>
</tr>
<tr>
<td><strong>Down-Arrow</strong></td>
<td>Moves you down one record.</td>
</tr>
<tr>
<td><strong>Ctrl++</strong></td>
<td>Creates a new record.</td>
</tr>
</tbody>
</table>
To use the Navigation bar to move around a table:

1. Go to First Record
2. Go to Previous Record
3. The Current Record
4. Go to Next Record
5. Go to Last Record
6. Create a New (Blank) Record

To modify existing data, simply navigate to the record of interest and tab to the appropriate field then change the existing data.

To delete a record, first navigate to the record which one you want to delete. Then pull down the Edit menu and choose Delete record and click on it.

To close the table and return to the Access main screen, pull down the File menu and choose the Close menu item.

**Delete a Record**

1. Open a datasheet.
2. Click the record you want to delete.
3. Click Delete Record on the toolbar.

**Save a Record**

Microsoft Access automatically saves the record when you are adding or editing as soon as you move the insertion point to a different record, or close the form or datasheet you are working on.

To explicitly save the data in a record while you are editing it, click Save Record on the Records menu.
Office Automation

Exercise

1. Multiple choice questions

a. Which one is the foundation of an Access Database?

   i) tables
   ii) forms
   iii) queries
   iv) none of the above.

b. Memo data type can store

   i) up to 64,000 characters
   ii) up to 44,000 characters
   iii) up to 60,000 characters
   iv) up to 6,000 characters.

2. Analytical questions

1. Discuss about data types.
2. Write down the steps to create a new table in design view.
3. Write down the steps required to change the structure of an existing table.
4. How you can enter data to a table.

Hands on Practice

1.

   a) Create a database and save it as sst
   b) Create a table containing 3 columns and 5 rows and insert 5 records.
   c) Save the table as bou.
   d) Select the 3rd record.
   e) Delete 2nd record.
   f) Select 1st record.
   g) Create blank (new) record.
Unit 9: Sorting, Filtering, Indexing and Creating Relationship Database

Introduction

You can sort data. You can view records in the order you want to view them, and you can filter data, so that you only see the records which you want to see. We will learn how to sort and filter an Access table in this lesson. Access data is stored in multiple tables. Relationships join tables together so you can work with the data from multiple tables. This lesson also teaches you how to create relationships.

Lesson 9.1: Understanding Sorting and Filtering

Learning Objectives

On completion of this lesson you will be able to learn:

- about sorting.
- about filtering.

9.1.2 Sorting a Table

When sorting records in Microsoft Access table, you can view a column of information in alphabetical, numerical, or date order. You can sort in ascending order (alphabetical from A to Z, lowest number to highest number, previous date to latest date) or descending order (alphabetical from Z to A, highest number to lowest number, latest date to previous date). You can also sort within a sort. For example, you can sort by state and then sort within each state by city. When sorting within a sort, perform the innermost sort first. For example, if you are sorting by state and then city, sort the state first and then sort by city.

Sorting Records in a Microsoft Access Table

To sort records in Datasheet view, follow these steps:

1. Start Microsoft Access, and then open the database that you are working with.
2. Open the table whose data you want to sort.
3. Click the field that you want to use for sorting records.
Sorting, Filtering, Indexing and Creating Relationship Database

4. On the Records menu, point to Sort, and then click Sort Ascending or Sort Descending.

Example: Sorting with datasheets

![Sorting with datasheets](image)

After Sorting the Access table looks like as follows:

![Sorted Access table](image)

To remove a sort:

On the Records menu click remove sort.
Office Automation

9.1.3 Filter a Table

You can apply filter to see only the records which you want to view. For example, perhaps your database contains emp id 001, 002, 003, 004, 005, 006 from these you only want to see the emp id 003. You can filter your data so that only emp id 003 will display.

Each time you apply a filter to a column, it replaces any previous filter you applied to that column. For example, if you apply a filter so that you only see emp id 003, and later you apply a filter so you only see emp id 005, Access clears the 003 filter and then applies the 005 filter.

Dear learners if you want to apply filter records in Datasheet view, follow these steps:

1. Start Microsoft Access, and then open the database that you are working with.
2. Open the table whose data you want to filter.
3. Click the field that you want to use for filtering records.
4. On the Records menu, point to filter, and then click filter by selection.
   Or Click filter by selection from toolbar.

Example: Filtering
Sorting, Filtering, Indexing and Creating Relationship Database

After filtering:

To remove a filter:

On the Records menu click remove filter or click remover filter from toolbar.
Exercise

1. *Multiple choice questions*

a. Each time you apply a filter to a column.
   
i) it replaces any previous filter you applied to that column.
   ii) it does not replaces any previous filter you applied to that column.
   iii) it replaces record.
   iv) none of the above.

b. You can apply a filter to see.
   
i) only records which you want to view.
   ii) only field which you want to view.
   iii) only table which you want to view.
   iv) none of the above.

c. When sorting records you can view.
   
i) a column of information.
   ii) one record of information.
   iii) all record of information.
   iv) a column of information in order.

2. *Analytical questions*

1. What is sorting? How you can sort records in Microsoft Access table.
2. What is filtering? How you can filter records in Microsoft Access table.
Lesson 9.2: Understanding Indexing and Relationship

Learning Objectives

On completion of this lesson you will be able to learn:

- about indexing.
- about relationship.

9.2.1 Indexing Fields and Records in an Access Database

An index speeds up queries on the indexed fields as well as sorting and grouping operations. Access uses indexes in a table as you use an index in a book: to find data, it looks up the location of the data in the index. For example, if you search for specific employee names in a department field, you can create an index for this field to speed up the search for a specific name. You can create indexes based on a single field or on multiple fields. Multiple-field indexes enable you to distinguish between records in which the first field may have the same value.

9.2.2 Deciding Which Fields to Index

The primary key of a table is automatically indexed, and you can't index a field whose data type is OLE Object. For other fields, you should consider indexing a field if all the following apply:

- The field's data type is Text, Number, Currency, or Date/Time.
- You anticipate searching for values stored in the field.
- You anticipate sorting values in the field.
- You anticipate storing many different values in the field. If many of the values in the field are the same, the index may not significantly speed up queries.

Indexed Property

You can use the Indexed property to set a single-field index. The Indexed property uses the following settings.
### Creating a Single-Field Index

- Open a table in Design View.
- In the upper portion of the window, click the field that you want to create an index for.
- In the lower portion of the window, click in the Indexed property box, and then click Yes (Duplicates OK) or Yes (No Duplicates).

#### 9.2.3 Edit or Delete an Index

- Open the table in Design view.
- Click Indexes on the toolbar.
- Change indexes or index properties as desired.
- To delete an index, select the index name as desired click right mouse button and click delete rows in the Indexes window.

Dear learners Delete index removes only the index, not the field itself.

#### 9.2.4 Relationship in Access Database

This section describes how to define relationships in a Microsoft Access database. It includes the following topics:

- What Are Relationship?
- Types of Relationship.
9.2.5 Creating Relationship

In Access, you store data in multiple tables and then use relationships to join the tables. After you have created relationships, you can use data from all of the related tables in a query, form, or report. A primary key is a field or combination of fields that uniquely identify each record in a table. A foreign key is a field in one table that must refer the primary key in another table. You use primary keys and foreign keys to join tables together. In other words, you use primary keys and foreign keys to create relationships.

There are three valid types of relationships between tables:

- One-to-one relationship.
- One to many relationship.
- Many to many relationship.

One-to-One Relationship

Suppose you have table A and table B. In one-to-one relationship, each record in Table A can have only one matching record in Table B and each record in Table B can have only one matching record in Table A. This type of relationships is rare because if there is a one-to-one relationship, the data is usually stored in a single table. A one-to-one relationship is created if both of the related columns are primary keys or have unique constraints. However, one-to-one relationship can occur when you want to store the information in a separate table for security reasons, when tables have a large number of fields, or for other reasons. The following figure illustrates one-to-one relationship.

<table>
<thead>
<tr>
<th>Customer</th>
<th>Account</th>
</tr>
</thead>
<tbody>
<tr>
<td>customer-id</td>
<td>account-no.</td>
</tr>
<tr>
<td>C001</td>
<td>A001</td>
</tr>
<tr>
<td>C002</td>
<td>A002</td>
</tr>
<tr>
<td>C003</td>
<td>A003</td>
</tr>
<tr>
<td>C004</td>
<td>A004</td>
</tr>
<tr>
<td>C005</td>
<td>A005</td>
</tr>
<tr>
<td>customer-name</td>
<td>balance</td>
</tr>
<tr>
<td>Rahim</td>
<td>200</td>
</tr>
<tr>
<td>Karim</td>
<td>100</td>
</tr>
<tr>
<td>Salam</td>
<td>350</td>
</tr>
<tr>
<td>Rafiq</td>
<td>700</td>
</tr>
<tr>
<td>Qader</td>
<td>1200</td>
</tr>
<tr>
<td>city</td>
<td></td>
</tr>
<tr>
<td>Dhaka</td>
<td></td>
</tr>
<tr>
<td>Pabna</td>
<td></td>
</tr>
<tr>
<td>Dhaka</td>
<td></td>
</tr>
<tr>
<td>Comilla</td>
<td></td>
</tr>
<tr>
<td>Sylhet</td>
<td></td>
</tr>
</tbody>
</table>

In the above example one customer should have only one account number and each account no can be associated only with one customer-id.
Office Automation

**One-to-Many Relationship**

A one-to-many relationship is the most common type of relationship. In a one-to-many relationship, a record in Table A can have many matching records in Table B, but a record in Table B has only one matching record in Table A.

When tables have a one-to-many relationship, the table with the one value is called the primary table and the table with the many values is called the related table. Referential integrity ensures that the validity of the relationship between two tables remains intact. It prohibits changes to the primary table that would invalidate an entry in the related table.

For example, one customer can have two account numbers. The following figure illustrated the one to many relationship.

![Customer and Account table](image)

**Many to Many Relationship**

In a many-to-many relationship, a record in Table A can have many matching records in Table B, and a record in Table B can have many matching records in Table A. This type of relationship is only possible by defining a third table called a junction table whose primary key consists of two fields — the foreign keys from
Sorting, Filtering, Indexing and Creating Relationship Database

both Tables A and B. A many-to-many relationship is really two one-to-many relationships with a third table.

The following figure illustrated the many to many relationships. In this example one customer can have one or many accounts and one account-no can have one or many customer.

<p>| | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### 9.2.6 How to Define Relationship between Tables

When you create a relationship between tables, the related fields do not have to have the same names. However, related fields must have the same data type unless the primary key field is an AutoNumber field. You can match an AutoNumber field with a Number field only if the Field Size property of both of the matching fields is the same.

To create relationship:

1. Close all tables and forms if you open because you can't create or modify relationships between open tables.

2. Activate the database window.

3. Click Relationships button from the toolbar.

4. Click show table from toolbar. The show table dialog box appears.
5. Activate the Tables tab if your relationships based on tables, activate the Queries tab if your relationships based on queries, or activate the both tab if your relationships will be based on both.

6. Double-click each table or query you want to use to build a relationship. The tables appear in the Relationships window.

7. Click the Close button to close the Show Table dialog box.

8. Drag the Primary table’s primary key over the related table’s foreign key. After you drag the primary key to the related table’s box, the cursor changes to an arrow. Make sure the arrow points to the foreign key. The Edit Relationships Dialog box appears.

9. Click the Enforce Referential Integrity checkbox.

10. Click Create. Access creates a one-to-many relationship between the tables.

11. Click the Save button on the Quick Access toolbar to save the relationship.
Note: When you create a relationship, you can view the related table as a sub datasheet of the primary table. Open the primary table and click the plus (+) in the far left column. The plus sign turns into a minus (-) sign. If the Insert Sub datasheet dialog box opens, click the table that you want to view as a sub datasheet and then click OK. Access displays the sub datasheet each time you click the plus sign in the far left column. Click the minus sign to hide the sub datasheet.
9.2.7 Delete a Relationship

After a relationship has been created between two tables, you must delete the relationship before you can make modifications to the fields on which the relationship is based.

To delete a relationship:

1. Close any tables you have open because you can't delete relationships between open Tables.
2. Activate the database window.
3. Click Relationships (on the toolbar.
4. If the tables whose relationship you want to delete aren't displayed, click Show Table on the toolbar and double-click each table you want to add. Then click Close.
5. Click the relationship line for the relationship you want to delete (the line will turn bold when it's selected), and then press the delete key.
6. Click the Save button on the Access toolbar to save.
Sorting, Filtering, Indexing and Creating Relationship Database

Exercise

1. **Multiple choice questions**

   a. An index helps to find and sort records.
      
      i) faster
      ii) slower
      iii) similar
      iv) none of the above.

   b. Which one is the most common type of relationship?
      
      i) one to many relationship
      ii) one to one relationship
      iii) many to many relationship
      iv) two to one relationship.

   c. You can create indexes based on.
      
      i) a single field
      ii) on multiple fields
      iii) both i and ii
      iv) none of the above.

2. **Analytical questions**

   1. What is an indexing? Explain with example.
   2. How can you create single field index?
   3. How can you edit and delete an index?
   4. Discuss the different types of relationships between tables.
   5. Write down the steps required to define relationships.
Unit 10: Microsoft Access Queries

Introduction

Queries are a fundamental means of accessing and displaying data from tables. Queries used to view, update, and analyze data in different ways. Queries can access a single table or multiple tables. For example, you want to view a list of employee id and name, but you do not want to see phone number and other data, you can create a query that displays the employee’s id and name only. Alternatively, if you want to know which employee lives in Dhaka, you can restrict your list to those employees. We will know how to create query in this lesson.

Lesson 10.1: Different Types of Queries

Learning Objectives

On completion of this lesson you will be able to learn:

- about queries.
- different types of queries.

10.1.1 Query

- Tables store all the information in a database, but if you want to view only selected fields and records in the database, you use a query.

- A query extracts specific data from one or more tables based on search criteria.

- For example, you could create a query for the customer table that will list all customers according to the city they belong. Next page will show the output of such query.

A query is a way of extracting specific data or information from a database. As you know tables store all information in database, if you want to view only selected fields and records in a database, you use query. For example you can create a query for the students table which will view the students who got gp 5.
10.1.2 Types of queries in Microsoft Access:

There are five types of query in Access. They are:

- Select queries
- Action queries
- Parameter queries
- Crosstab queries
- SQL queries.

Select Queries

Select query is the simplest and the most common type of query. It retrieves data from one or more tables depending on what is needed and displays the result in a datasheet. Select query also use to group records and calculate sums, counts, averages, and other types of totals.

Action Queries

Database undergoes a specific action depending on what was specified in the query itself is known as action query. This can include such things as creating new tables, deleting rows from existing ones and updating records or creating entirely new ones. Action queries are very popular in data management because they allow for many records to be changed at one time.

There are four types of action queries:

- Append Queries: An append query add records from one or more tables to the end of one or more tables. For example, you have some new customers and a database containing a table of information on those customers. To avoid typing all this information into your own database, you can append it to your Customers table.

- Update Queries: An update query makes global changes to a group of records in one or more tables. For example, you can increase employee’s salary by 20 percent for the people within a certain job category. With an update query, you can change data in existing tables.
• Delete Queries: A delete query deletes a group of records from one or more tables. Delete queries always delete entire records, not just selected fields within records. For example, you could use a delete query to remove products that are discontinued or for which there are no orders.

• Make-Table Queries: A make-table query creates a new table from all or part of the data in one or more tables. Make-table queries are helpful for creating a table to export to other Microsoft Access databases or a history table that contains old records. Making a backup copy of a table automatically by using a macro or code.

Parameter Queries

Instead of entering predetermined criteria, you want to prompt users when a query runs; you can create a parameter query. A useful feature of the parameter query is that it can be saved and used again and again whenever we want to ask the same question. When you run a parameter query Access displays dialog box prompting you for the parameter value. You can create a parameter query by enclosing a question in square brackets ([]). For example, if you want to create a parameter query that asks users which id you want to use from the Student’s table, you would type [Which id?] on the Criteria line under the id column. When the query runs, Access will prompt the user for the answer to your question.

Crosstab Queries

You use crosstab queries to calculate and restructure data for easier analysis of your data. Crosstab queries calculate a sum, average, count, or other type of total for data that is grouped by two types of information one down the left side of the datasheet and another across the top.

SQL Queries

An SQL query is created by using an SQL statement. When you create a query in query Design view, Access constructs the equivalent SQL statements behind the scenes for you. In fact, most query properties in the property sheet in query Design view have equivalent clauses and options available in SQL view. If you want, you can view or edit the SQL statement in SQL view. However, after you make changes to a query in SQL view, the query might not be displayed the way it was previously in Design view.
Exercise

1. **Multiple choice questions**

   a. How many types of queries have in Microsoft Access?
      
      i) 4
      ii) 5
      iii) 6
      iv) 3.

   b. Which query allow many records to be changed at one time instead of single record
      
      i) action query
      ii) select query
      iii) parameter query
      iv) crosstab query.

2. **Analytical questions**

   1. What is query? Write the names of all types of query.
   2. Discuss about action query.
   3. Discuss about SQL query.
Lesson 10.2: Creating Microsoft Access Queries

Learning Objectives

On completion of this lesson you will be able to learn:

- creating query.
- saving query.
- retrieving all records and all fields.
- retrieving single column.
- retrieving multiple columns.
- creating parameter query.

10.2.1 Creating Queries

Open Tables or Queries in Query Design View

A query can be based on tables or on other queries. To create a query, you open the tables or queries on which you are going to base your query in Query Design view, and then use the options in Design view to create your query. You then click the Run button to display the results. You can save queries for later use.

To open tables or queries in Query Design view:
Microsoft Access Queries

1. Activate the Create tab.
2. Click the Query Design button in the other group. The Show Table dialog box appears.
3. Activate the tables tab if you want to base your query on tables, activate the Queries tab if you want to base your query on queries or activate the both tab if you want to base your query on both tables and queries.
4. Click to choose the table or query on which you want to base your query.
5. Click Add. The table appears in the window.
   - Click to choose the next table or query on which you want to base your query.
   - Continue clicking tables or queries until you have all the tables and queries you plan to use.
6. Click Close. Access changes to Query Design view.

10.2.2 To save a query:

1. Click the Save button on the Quick Access toolbar. Access saves the query unless you are saving for the first time. If you are saving for the first time, the Save As dialog box appears.
2. Type the name you want to give your query.
3. Click OK. Access saves the query. You can now access the query by using the Navigation pane.

You can also save by right-clicking a query’s tab and then selecting save from the menu that appears. Access saves the query unless you are saving for the first time. If you are saving for the first time, the Save As dialog box appears. Type the name you want to give the query and then click OK. Access saves the query. You can now access the query by using the Navigation pane.

10.2.3 Retrieve All Records and All Fields

In Query Design view, each table has an option that allows you to display all of the fields and all of the records in a table. This option appears on the field line on the drop-down menu as the table name followed by a period and an asterisk (tablename.*).
To display all records and all fields:

1. Open query in Query Design view.
2. Click the down-arrow in the first field on the Field row ( ) and then select the tablenamel.* (emp. *) option. The table name appears on the table line.
3. Click the Run ( ) button. Access retrieves all of the fields and records for the table and displays them in Datasheet view like as follows.

**10.2.4 Retrieve a Single Column**

You can use an Access query to retrieve a single column of data. Instead of choosing the tablenamel.* option on the Field line in Query Design view, choose the name of the field you want to retrieve.
To retrieve a single column:
1. Open query in Query Design view.
2. Choose the field name you want to display in the field line.
3. Select the Show button for the columns you do not want to display
4. Click the Run button. Access retrieves the column you chose.

10.2.5 Retrieve Multiple Columns
You can use an Access query to retrieve multiple columns of data. On the Field line in Query Design view, choose the field name of each field you want to retrieve in the order you want to retrieve them.
Office Automation

To retrieve multiple columns:
1. Open query in Query Design view.
2. Choose the field names you want to retrieve in the order you want to retrieve them.
3. Click the Run button. Access retrieves the columns you chose.

10.2.6 Creating a Parameter Query

To create a parameter query:

1. Open a table or query in Query Design view.
Microsoft Access Queries

2. Create your query.
3. On the Criteria line, type the prompt within square brackets.
4. Click the Run button. Access prompts you. Dialog box that allows you to enter yours query parameter.
5. Respond to the prompt.
6. Click OK. Access displays the results of your query in Datasheet view.
Office Automation

You can have as many parameters as you like in a single query. For example, you can design it to prompt you for two values. Access can then retrieve all records that fall between those two values. In this example the query would display all the record which contained employee id in the range 001 to 004.

After performing result looks as follows
Microsoft Access Queries

Note: If you want to make your user prompt more flexible, use one of the following formats.

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Like &quot;<em>&quot; &amp; [Prompt] &amp; &quot;</em>&quot;</td>
<td>Returns all records that contain the value you enter. Example: If you enter ad, Access returns all records that include the sequence ad anywhere in the field.</td>
</tr>
<tr>
<td>Like &quot;*&quot; &amp; [Prompt]</td>
<td>Returns all records that end with the value you enter. Example: If you enter S, Access returns all records that end with S.</td>
</tr>
<tr>
<td>Like [Prompt] &amp; &quot;*&quot;</td>
<td>Returns all records that begin with the value you enter. Example: If you enter S, Access returns all records that begin with S.</td>
</tr>
<tr>
<td>&gt; [Prompt]</td>
<td>Find all records with a value greater than the value you enter. Example: If you enter 5, Access returns all records that are greater than 5.</td>
</tr>
</tbody>
</table>

Note: You can also use < (less than), <= (less than or equal to), >= (greater than or equal to), or <> (not equal).
Exercise

1. **Multiple choice questions**

   a. Which format returns all records that end with the value you enter?
      
      i) like "*" & [Prompt] & "*"
      ii) like "*" & [Prompt]
      iii) like [Prompt] & "*"
      iv) > [Prompt].

   b. How you can create a parameter query?
      
      i) by enclosing a question in []
      ii) by enclosing a question in ()
      iii) by enclosing a question in {}
      iv) none of the above.

2. **Analytical questions**

   1. What is parameter query? How you can create parameter query?
   2. Write the steps required to create query?
   3. Write the steps required to display all records and all fields?
Lesson 10.3: Advanced Queries

Learning Objectives

On completion of this lesson you will be able to learn:

- logical operators.
- retrieving specific records.
- sorting query.
- modifying query.
- query to make table.

10.3.1 Logical Operators

The logical operators and their meanings are shown in the table below.

<table>
<thead>
<tr>
<th>Logical Operators</th>
<th>Meaning</th>
<th>Field Type</th>
<th>Entry Format</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>=</code></td>
<td>Equal to</td>
<td>Character</td>
<td>= &quot;abc&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Number</td>
<td>= 5</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Date</td>
<td>= #11/12/10#</td>
</tr>
<tr>
<td><code>&lt;&gt;</code></td>
<td>Not equal to</td>
<td>Character</td>
<td>&lt;&gt; &quot;ab&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Number</td>
<td>&lt;&gt; 5</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Date</td>
<td>&lt;&gt; #11/12/10#</td>
</tr>
<tr>
<td><code>&gt;</code></td>
<td>Greater than</td>
<td>Character</td>
<td>&gt; &quot;abc&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Number</td>
<td>&gt; 5</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Date</td>
<td>&gt; #11/12/10#</td>
</tr>
<tr>
<td><code>&gt;=</code></td>
<td>Greater than or</td>
<td>Character</td>
<td>&gt;= &quot;abc&quot;</td>
</tr>
<tr>
<td></td>
<td>equal to</td>
<td>Number</td>
<td>&gt;= 5</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Date</td>
<td>&gt;= #11/12/10#</td>
</tr>
<tr>
<td><code>&lt;</code></td>
<td>Less than</td>
<td>Character</td>
<td>&lt; &quot;abc&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Number</td>
<td>&lt; 5</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Date</td>
<td>&lt; #11/12/10#</td>
</tr>
<tr>
<td><code>&lt;=</code></td>
<td>Less than or equal to</td>
<td>Character</td>
<td>&lt;= &quot;abc&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Number</td>
<td>&lt;= 5</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Date</td>
<td>&lt;= #11/12/10#</td>
</tr>
<tr>
<td>Condition</td>
<td>Description</td>
<td>Character</td>
<td>Number</td>
</tr>
<tr>
<td>-------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-----------</td>
<td>--------</td>
</tr>
<tr>
<td>In</td>
<td>Equal to any item in a list</td>
<td>Character</td>
<td>Number</td>
</tr>
<tr>
<td></td>
<td>In (&quot;ab&quot;, &quot;fg&quot;)</td>
<td>In (5, 17)</td>
<td></td>
</tr>
<tr>
<td>Not In</td>
<td>Not equal to any item in a list</td>
<td>Character</td>
<td>Number</td>
</tr>
<tr>
<td></td>
<td>Not In (&quot;ab&quot;, &quot;fg&quot;)</td>
<td>Not In (5, 17)</td>
<td></td>
</tr>
<tr>
<td>Between</td>
<td>Between two values, greater than or equal to one and less than or equal to the other</td>
<td>Character</td>
<td>Number</td>
</tr>
<tr>
<td></td>
<td>Between &quot;C&quot; And &quot;F&quot;</td>
<td>Between 5 And 10</td>
<td></td>
</tr>
<tr>
<td>Not Between</td>
<td>Not between two values</td>
<td>Character</td>
<td>Number</td>
</tr>
<tr>
<td></td>
<td>Not Between &quot;C&quot; And &quot;F&quot;</td>
<td>Not Between 5 And 10</td>
<td></td>
</tr>
<tr>
<td>Is Null</td>
<td>The value is missing from the field</td>
<td>Character</td>
<td>Number</td>
</tr>
<tr>
<td></td>
<td>Is Null</td>
<td>Is Null</td>
<td></td>
</tr>
<tr>
<td>Is Not Null</td>
<td>The value is not missing from the field</td>
<td>Character</td>
<td>Number</td>
</tr>
<tr>
<td></td>
<td>Is Not Null</td>
<td>Is Not Null</td>
<td></td>
</tr>
<tr>
<td>Like</td>
<td>Like a specified pattern. * means any series of characters. ?means any single character.</td>
<td>Character</td>
<td>Number</td>
</tr>
<tr>
<td></td>
<td>Like &quot;a*&quot;</td>
<td>Not Applicable</td>
<td></td>
</tr>
<tr>
<td>Not Like</td>
<td>Not like a specified pattern. * means any series of characters. ? means many single character.</td>
<td>Character</td>
<td>Number</td>
</tr>
<tr>
<td></td>
<td>Not Like &quot;a*&quot;</td>
<td>Not Applicable</td>
<td></td>
</tr>
</tbody>
</table>
10.3.2 Retrieving Specific Records using Criteria:

So far, you have been retrieving all of the records (rows) in our table. However, you can specify which records you wish to retrieve.

For example, you can retrieve only the employee whose employee id number is 005, or employee name is mamun or only those whose date of birth is 29/12/80. For this we use logical operators such as = (equal), \(<\) (not equal), \(\geq\) (greater than), or \(<\) (less than). For example, to display employee name mamun enter ="mamun" in the empname column on the Criteria line. Access will only retrieve records where the value in the empname column is equal to “mamun”. Selection criteria are not case-sensitive, so Access will retrieve records where the entry is MAMUN,mamun, Mamun, or mAMun.

When using the Like and Not Like criteria, where you place the asterisk (*) or question mark (?) determines the type of searching Access performs.

Like "Ma*" finds all records in the field that begin with Ma. It would find Mamun, Manik, and Male.

Like "*ny" finds all records in the field that end with ny. It would find jony, rony, and sony.

Like "*123*" finds all records that contain 123 anywhere in the field. It would find 422123789, 123456789, and 78945123.

The sequence Like "?oy" finds all three character field entries where the second and third characters are oy. It would find Boy, Toy, and Joy.

The sequence Like "Jo?" finds all three character field entries where the first and second characters are Jo. It would return Joe, Joy, and Jon.

The sequence Like "T?m" finds all three character field entries where the first and third characters are T and m. It would return Tim, Tom, and Tam.

To retrieve specific records using criteria:

1. Open a query in Query Design view.
2. Select the Show button for columns you do not want to display.
3. Enter your selection criteria on the Criteria line.
4. Click the Run button. Access retrieves the columns you chose and displays the rows.
After retrieving specific records looks like as follows:

10.3.3 Retrieve records using Multiple Criteria

You can apply multiple criteria to the same table. If you place two criteria on the same line, Access will only retrieve records where both criteria are met. For example, if you want all records where the empname Like "Ma*" and the phone number is equal to 029010556, you would set the empname field to = "Ma*" and the phone number field to = "029010556" and you would place both criteria on the same line.
If you place one set of criteria on the Criteria line and the second set of criteria on the Or line, Access will retrieve records if either criteria are met. For example, you want all records where the employee name is equal to "mamun" or the employee name is equal to labib or the phone number is equal to 01717224501. You would set the empname field to = "mamun", or empname field to = "labib" and the phone number field to = "01717224501" and you would place one set of criteria on the Criteria line and the other set of criteria on the Or line. Access will display all records where the employee name equals mamun or labib or Phone number is equal to 01717224501. You can add additional and, or statements by using the lines below the Or line. For And clauses, place the criteria on the same line; for Or clauses, place the criteria on separate lines.

**To apply multiple criteria:**

1. Open a query in Query Design view.
2. Select the Show button for columns you want to display.
3. Enter your selection criteria on the Criteria line and or line as needed.
4. Click the Run button. Access retrieves the columns you chose and displays the rows.

**To retrieve record if either criteria is true:**

![Emp Query Image]
To retrieve records if both criteria are true:
Microsoft Access Queries

If the both criteria are true the result will be as follows:

If the both criteria are not true then none record will be retrieve.

10.3.4 Sorting Query

When creating a query, you can sort the rows you retrieve in ascending or descending order by choosing the option you want on the Sort row in Query Design view.

To Perform a Sort:

1. Open query in Query Design view.
2. Choose the field names you want to retrieve in the order you want to retrieve them.
3. Under the field you want to sort, click the down-arrow and then choose Ascending or Descending.
4. Click the Run button. Access retrieves the columns you chose and displays the rows in the order you specified.
10.3.5 Modify a Query

Once a query is created, it can be modified. To modify query simply open the query in Query Design view and make the changes. You can add columns, change the sort order, change the criteria, and make other changes.

Use the Insert Columns button to insert a column. Click anywhere in the column before which you want to insert a column and then click the Insert Column button.

Use the Delete Rows button to delete a row in the criteria area. Click anywhere in the row you want to delete and then click the Delete Row button.

Use the Delete Columns button to delete a column. Click anywhere in the column you want to delete and then click the Delete Column button.
10.3.6 Query to Make a Table

You can use a query to create a table. This is useful when you want to create a new table that includes the fields and data from an existing table.

To create a table:

1. Open the table or query on which you want to base your new table on in Query Design view.
2. Enter the criteria on which you want to base your new table.
3. Click the Make Table button. The Make Table dialog box appears.
4. Type the name you want to give your new table.
5. Click OK.
6. Click Run.
7. Click Yes.
8. Close the query. (Right-click the query’s tab and then click Close.)
9. Double-click the new table’s name in the Navigation pane to view the new table.
Office Automation

Make Table

Table Name: empnnew

Current Database

Another Database:

File Name:

OK

Cancel

Microsoft Access
You are about to paste 6 row(s) into a new table.

Once you click Yes, you can't use the Undo command to reverse the changes.
Are you sure you want to create a new table with the selected records?

Yes

No

sst : Database (Access 2000 file format)

Objects

Tables

Queries

Forms

Reports

Pages

Macros

Modules

Groups

Favorites

Create table in Design view

Create table by using wizard

Create table by entering data

emp

empnnew

student
<table>
<thead>
<tr>
<th>emp id</th>
<th>empname</th>
<th>phone number</th>
</tr>
</thead>
<tbody>
<tr>
<td>004</td>
<td>mamun</td>
<td>029010556</td>
</tr>
<tr>
<td>001</td>
<td>labib</td>
<td>01716115139</td>
</tr>
<tr>
<td>002</td>
<td>babul</td>
<td>01717224501</td>
</tr>
<tr>
<td>003</td>
<td>rahim</td>
<td>01122334411</td>
</tr>
<tr>
<td>005</td>
<td>alim</td>
<td>01718355945</td>
</tr>
<tr>
<td>006</td>
<td>sharif</td>
<td>01728516824</td>
</tr>
</tbody>
</table>
Exercise

1. **Multiple choice questions**
   
a. Selection criteria are
   
i) case sensitive
   ii) not case sensitive
   iii) any one of the above.
   iv) none of the above.
   
b. Like "J?m" finds which three character
   
i) Jim
   ii) jam
   iii) joy
   iv) both i and ii.

2. **Analytical questions**
   
1. Discuss about retrieving data using multiple criteria.
2. How you can modify a query?
3. How you can create a table using query and when it is useful?

Hands on Practice

1. 
   a) Create a table containing 3 columns and 5 rows and save the table as sst.
   
b) Create a query to retrieve all records and fields.
   
c) Retrieve specific records using criteria.
   
d) Sorts records in ascending order.
   
e) Create a table as bou using query.
Unit 11. Introduction to Form and Report

Introduction:

Databases are made to be used. Access provides an easy way to enter data into Access database tables with forms. Forms can also use to edit, update or display data. Forms offer more user-friendly interface by adding labels for each field and other helpful information.

Switchboards: You can create form that appears as a switchboard. The switchboard provides a friendly and controlled way to open forms, reports, and other objects. It guides users to the actions that you want them to perform, and screens parts of your database.

Lesson 11.1: Form

Learning Objectives

On completion of this lesson you will be able to learn:

- about form.
- creating form.
- about form toolbox.

11.1.1 Form

A form is a graphical representation of a table. Generally a form is created to enter data efficiently and accurately in a table. It is like a window into a table, designed to display the data. Forms can be designed to show all or some of the fields in a table or to combine the fields from two or more tables.

All sorts of people need to add and review data quickly and effectively. Entering data in a form is more efficient than entering it in a table. A visually attractive form makes working with the database more pleasant and more efficiently.

11.1.2 Creating Form

Access offers two main methods of creating a new form.

1. Design view.
2. Form Wizard
Creating Form in Design View

Design view is the best way to create a form when you want full control and complete freedom. In Design view, everything is up to you.

To start working in Design view:
1. In the database window click Forms under Objects.
2. Click the New button on the Database window toolbar.
3. In the New Form dialog box click Design View to select this method.
4. Click the name of the table or other record source that includes the data you want to base your form on.
5. Click OK.
After Design

To see the form as it will appear you can open it in Form view and keep switching between Form and Design views until the form suits you completely.

Navigation Button

1. First record
2. Previous record
3. Record number
4. Next record
5. Last record
6. New record

Access automatically adds navigation button to every new form because they are so convenient. The navigation button isn't visible in Design view, but it appears whenever you switch to Form view. Using navigation button users move quickly and easily back and forth among the records or to the end of the existing records to create a new record.
Creating Form by using Wizard

The Form Wizard is best when you want to be guided step by step through the process of creating a form. The Form Wizard asks you questions and creates a form based on your answers.

You will need to tell the wizard:

- Which table or query the form data comes from?
- Which fields to use on the form?
- Which form layout to apply?
- Which visual style to apply?

To create form using wizard:

1. In the database window click Forms under Objects.
2. Click the New button on the Database window toolbar.
3. In the New Form dialog box click one of the following wizards:
   - AutoForm: Columnar each field appears on a separate line with a label to its left.
   - AutoForm: Tabular the fields in each record appear on one line, with the labels displayed once at the top of the form.
   - AutoForm: Datasheet the fields in each record appear in row-and-column format, with one record in each row and one field in each column. The field names appear at the top of each column.
   - AutoForm: PivotTable the form opens in PivotTable view. You can add fields by dragging them from the field list to the different areas in the view.
   - AutoForm: PivotChart the form opens in PivotChart view. You can add fields by dragging them from the field list to the different areas in the view.
4. Click the table or query that includes the data you want to base your form on.
5. Click OK.
Office Automation

Fig. A columnar AutoForm

Fig. A tabular AutoForm
Introduction to Form

11.1.3 Toolbox

The Toolbox contains a set of controls that are used to receive user input and display output on a form at design time. Controls have own set of properties, methods and events. Properties define aspects of their appearance such as size, color etc and aspects of their behavior such as their response to the user input. A method is an action that can be performed on objects.

Label - A Label control is a graphical control which is used to displays text that user can not modify directly.

On a Form

1. Open a form in design view
2. Click the Label tool in the toolbox.
3. Click the section on the form where you want to place the label.
4. Set other properties to customize the visual appearance of the label and its contents.

* To set properties for control click the control and then click Properties on the toolbar.

Textbox - Textbox control sometimes called an edit field or edit control is used to display information at design time or assigned to the control in code at run time.
Office Automation

On a form

1. Open a form in design view
2. Click the Text box in the Toolbox.
3. Click in detail section where you want to place the textbox.
4. Set other properties to customize the visual appearance.

* To set properties for control click the control and then click Properties on the toolbar.

The Textbox control has associated methods such as refresh, Setfocus, etc. The Setfocus method moves the focus the control. The Textbox control supports various events such as change, click, and many more that will be listed in the properties drop-down list in the code window for the textbox control. As for example-The code entered in change event executes when there is a change in the contents of the textbox. The Click event fires when the Textbox control is clicked.

Command button- The Command button carries out the specified action as desired of user. In other words a command button control is used to begin, interrupt, or end a process. To display text on a command button control, set its Caption property. An event can be activated by clicking a command button.

Check box - Check box displays a True/False or Yes/No option.

List Box - List Box display a list of items from which you can select one.

Image –Image control is used to display icons, bitmaps etc.

Picture Box- Picture Box displays icons/bitmaps files. It also displays text or acts as a visual container for other controls.

Frame control-Frame control serves as a visual and functional container for controls.

Shape control- Shape control adds a shape (rectangle, square or circle) to a form.

Line control- Line control draws a straight line to a form.

Pointer- pointer provides a way to move and resize the controls and forms.
Exercise

1. **Multiple choice questions**
   
a. Navigation button is visible
   
i) design time  
ii) form view  
iii) both i and ii  
iv) none of the above.

b. Which control display a list of items from which you can select one?
   
i) list Box  
ii) check box  
iii) picture bix  
iv) shape control.

c. Field in each record appear in row and column format with one record in each row and one field in each column
   
i) autoform columnar  
ii) autoform tabular  
iii) autoform datasheet  
iv) autoform PivotTable

2. **Analytical questions**
   
1. What is Form? Write the benefits of form.
2. Write the steps required to create a form in design time.
3. Write the steps required to create a form using wizard with examples?
4. Discuss about the controls of Form toolbox.
Lesson 11.2: Designing Report

Reports are the end product of database and report is an effective way to present data in a printed format. You can group your assets by supplier and calculate a subtotal for each group, as well as a grand total for all groups. In this lesson we will discuss about creating, modifying, and sections reports.

Learning Objectives

On completion of this lesson you will be able to learn:

- about report.
- about sections of report.
- creating report.

11.2.1 Report

One database may have many reports. Some will be based on one table data others may be based on specific queries. As the data changes (added or deleted) or the query changes the report is changes automatically.

11.2.2 About Sections of a Report

The information in a report can be divided into sections. Each section has a specific purpose and prints in a predictable order in the report. Access report layout consists of five major sections. Within these sections you can place fields, text, and graphics.

Five major sections are as follows:

1. Report header
2. Page header
3. Detail (data from tables)
4. Page footer
5. Report footer
Introduction to Form

The report header appears once at the beginning (First page) of report. As for example such as company logo, introductory information, or report title. The report header is printed before the page header on the first page of the report.

The page header appears at the top of each page in the report often used to display information such as report titles.

The detail section is the main body of report’s data. All reports must have a detail section.

The page footer appears at the bottom of every page in the report. Page footer is similar to page header except that it appears at the bottom of each page. It is used to display items such as page numbers, printing date. You can also create group footers that display sums, counts, or averages for a group of data.

The report footer appears once at the end of the report. It is used to display items such as report totals. The report footer is the last section in the report design but appears before the page footer on the last page of the printed report.
11.2.3 Creating Report

There are three ways to create a report.

- Creating report in Design view.
- Creating report using Wizard.
- Creating report using Autoreport.

Creating Report in Design View

You can create and customize report in Design view

1. In the database window click Reports under Objects
2. Click the New button on the Database window toolbar.
4. Click the table or query that contains the data you want to base your report on.
5. Click OK.
You can use Toolbox to enhance Visual appearance of your report. Click the
label tool from toolbox, place it in the report header section and type
Bangladesh Open University. Set other properties to customize the visual
appearance of the label and others tool and its contents.
Office Automation

**Creating Report using Wizard**

The wizard asks you detailed questions about the record sources, fields, layout, and format you want and creates a report based on your answers.

1. In the database window click Reports under Objects.

2. Click the New button on the Database window toolbar.

3. In the New Report dialog box click the wizard that you want to use. In the left side of the dialog box description of the wizard appears.

4. Click the table or query that contains the data you want to base your report on.

5. Click OK.

6. Follow the instructions in the wizard.

If the resulting report doesn't look as you desire you can change it in Design view.
Introduction to Form

Fig. A columnar layout.
Office Automation

Fig. A tabular layout.
Introduction to Form

AutoReport creates a report that displays all fields and records in the underlying table or query.

1. In the database window click Reports under Objects.
2. Click the New button on the Database window toolbar.

3. In the New Report dialog box click one of the following wizards: AutoReport: Columnar each field appears on a separate line with a label to its left.
   AutoReport: Tabular the fields in each record appear on one line and the labels print once at the top of each page.

4. Click the table or query that contains the data you want to base your report on.

5. Click OK.

11.2.4 Saving a Report

You can either click on File (in the Menu Bar) and then Save, or Save As, or click on the small diskette button ( ) in the button bar. A menu window will open which asks Save As. In the area under Report Name type the name of the report and click on OK. Click on the File in the Menu Bar and then click on Close.

![Save As dialog box](image)

Now when you return to the Database Window, you will see your report is in the list.
11.2.5 Open a Report

1. In the database window click Reports under Objects.
2. Click the report which you want to open.
3. Do one of the following:
   - Click Design on the Database window toolbar to open the report in Design view.
   - Click Preview on the Database window toolbar to open the report in print preview.

11.2.6 Modifying a Report

1. To modify a report open the report and go to Design view
2. Edit the field designs by dragging, stretching or deleting.
3. Switch to the report view to see how it looks.
4. Repeat the procedure until the reports look good.
Office Automation

Exercise

1. Multiple choice questions

   a. Each field appears on a separate line with a label to its left
      i) autoReport: Columnar
      ii) autoReport: Tabular
      iii) autoReport: Datasheet
      iv) none of the above.

   b. Report must have a
      i) detail section
      ii) page header section
      iii) page footer section
      iv) report header.

2. Analytical questions

   1. How to create a report using design view?
   2. How to create a report by using wizard?
   3. Discuss about sections of a report.
Lesson 11.3: Advanced Report

Learning Objectives

On completion of this lesson you will be able to learn:

- about Report Writer Toolbox.
- printing a report.
- display date and time and page numbers.
- calculating field.

11.3.1 Report Writer Toolbox

Label-A Label control is a graphical control which is used to displays text,

1. Open a report in design view.
2. Click the Label tool in the toolbox.
3. Click the section on the report where you want to place the label.
4. Set other properties to customize the visual appearance of the label and its contents.

* To set properties for control click the control and then click Properties on the toolbar.

Text Box-Textbox control is used to display information at design time or assigned to the control in code at run time.
1. Open a report in design view

2. Click the Text box in the Toolbox.

3. Click in detail section where you want to place the textbox.

4. Set other properties to customize the visual appearance.

* To set properties for control click the control and then click Properties on the toolbar.

Check box - Check box displays a True/False or Yes/No option.

List Box - List Box display a list of items from which you can select one.

Image –Image control is used to display icons, bitmaps etc.

Rectangle control- Rectangle control adds rectangle to a report.

Line control- Line control draws a straight line to a report.

Pointer- pointer provides a way to move and resize the controls and reports.

11.3.2 Drawing Rectangles and Lines

You can draw rectangles or lines in a report for separating different types of data. As for example a line could be drawn to separate headings from the data, or a rectangle could be drawn to enclose important summary data.

To draw line or rectangle:

1. In the report writer toolbox click on line control to draw a line or click on the rectangle tool to draw a rectangle.

2. Move the mouse pointer to the location at which you want to begin drawing and drag to draw.

   1. To change the thickness of a rectangle's border or of a line, click the rectangle or line, click Properties on the toolbar to open the property sheet, and then click in the Border Width button and then click the line thickness you want.

   2. To change the line style (dots, dashes, double, and so on) of a rectangle's border or of a line, click the rectangle or line, click Properties on the toolbar to open the property sheet, and then click a border style in the BorderStyle.
**Introduction to Form**

### 11.3.3 Show Current Date and Time in a Report

1. Open report in Design View.
2. From the Insert menu click Date and Time.
3. To include a date select the Include Date check box and then click a date format.
4. To include the time select the Include Time check box and then click a time format.
5. Click Ok.

![Date and Time dialog box](image)

### 11.3.4 Show Page Numbers in a Report

1. Open report in Design View.
2. From the Insert menu click Page Numbers.
3. Select the Format, Position, and Alignment.
4. Click Ok.

![Page Numbers dialog box](image)
11.3.5 Calculated Field in a Report

Calculated field can be based on any expression. For example to calculate house rent for employee, insert a calculated field with the multiplication expression basic salary * percentage of house rent.

To insert a calculated field:

1. Open report in Design view.
2. Click the Text Box tool in the toolbox.
3. In the detail section click where you want to place the text box.
4. Select the text box click Properties on the toolbar and type the expression in the ControlSource property box.
5. Or click the Build button next to the ControlSource property box.

For example, to multiply the value of field A by 2 types:

\[ = [A]*2 \]
Introduction to Form

11.3.6 Calculate a total or other aggregate values

Calculate a total or average on a report Open a report in Design view.

1. Click the Text Box tool on the toolbox.
2. Do one of the following:
   - To calculate a total or average for a group of records, add the text box to the group header or footer.
   - To calculate a grand total or average for all records in a report, add the text box to the header or footer of the report.
3. Select the text box and then click Properties on the toolbar.
4. In the ControlSource property box type an expression that uses the Sum function to calculate a total or the Avg function to calculate an average.

11.3.7 Printing a Report

Any report can be outputted to printer.

To Print a Report from Print Preview

Click the print button on the Print Preview toolbar to print document. The print dialog box will not appear.

To Print a Report using toolbar

Choose File ➔ Print from the menu bar to open the Print dialog box.
Make any necessary changes to the Print Range, Number Copies sections of the Print dialog box.

Click the OK button to print the report.
Exercise

1. *Multiple choice questions*

   a. Generally which control is used for separating different types of data?

      i) line
      ii) rectangle
      iii) list box
      iv) both i and ii

   b. To calculate a grand total for all records in a report add text box to the

      i) header of a report
      ii) footer of a report
      iii) header or footer of a report
      iv) page header of a report.

2. *Analytical questions*

   1. Write the uses of rectangles and lines.
   2. How to display current date and time and page numbers in a report.
   3. How to calculate a total or other aggregate values in a report.
   4. How to calculate a field in a report.

Hands on Practice

Create a report containing report header as Bangladesh Open University, page header as Result sheet, page footer as page number and printing date and the report layout will be tabular format and save the as sst.
Answers to MCQs:

Unit 8:

Lesson 8.1:
a. i), b. i), c. iv)

Lesson 8.2:
a. iii), b. i), c. i)

Lesson 8.3:
a. i), b. i)

Unit 9:

Lesson 9.1:
a. i), b. i), c. iv)

Lesson 9.2:
a. i), b. i), c. iii)

Unit 10:

Lesson 10.1:
a. ii), b. i)

Lesson 10.2:
a. ii), b. i)

Lesson 10.3:
a. iv), b. iv)

Unit 11:

Lesson 11.1:
a. ii), b. i), c. iii)

Lesson 11.2:
a. i), b. i)

Lesson 11.3:
a. ii), b. iii)
Further Reading
